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Chapter 1

Introducing
QuickBooks

Objectives

In this chapter, you will learn about the following:
e An overview of the QuickBooks product line (page 1)
e Some of the basic principles of accounting (page 2)
e The accounting behind the scenes in QuickBooks (page 4)
e An overview of QuickBooks data files and types (page 6)
e Opening portable files (page 8)
e How to restore backup files (page 10)
e Entering transactions in QuickBooks (page 16)
e QuickBooks user interface features (page 22)
e About QuickBooks help and support (page 25)

QuickBooks is one of the most powerful tools you will use in managing your business. In
addition to being a robust bookkeeping program, QuickBooks is a management tool. When set
up and used properly, QuickBooks allows you to track and manage income, expenses, bank
accounts, receivables, inventory, job costs, fixed assets, payables, loans, payroll, billable time,
and equity in your company. It also provides you with detailed reports that are essential to
making good business decisions. Throughout this book, you will learn in detail about most of
the features in QuickBooks.

QuickBooks helps small business owners run their businesses efficiently without worrying
about the debits and credits of accounting entries. However, to use QuickBooks effectively,
you still need to understand how QuickBooks is structured, how its files work, how to
navigate in the system to do tasks, and how to retrieve information about your business. In
this chapter you will explore the world of accounting and then you’ll learn some of the basics
of the QuickBooks program.

The QuickBooks Product Line

The QuickBooks family of products is designed to be easy to use, while providing a
comprehensive set of accounting tools including general ledger, inventory, accounts
receivable, accounts payable, sales tax, and financial reporting. In addition, a variety of
optional, fee-based payroll services, merchant account services, and other add-on products
integrate with the QuickBooks software.
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QuickBooks Editions

The QuickBooks product line includes four separate product editions: QuickBooks Online,
QuickBooks Pro, QuickBooks Premier, and QuickBooks Enterprise Solutions. The Premier and
Enterprise Solutions editions are further broken down into six industry-specific editions for
Accounting Professionals, Contractors, Manufacturers/Wholesalers, Nonprofit Organizations,
Professional Services, and Retailers. All editions of QuickBooks support multiple users, however,
each user must have the same version of QuickBooks to access the file.

This book covers the features and usage of QuickBooks Pro and Premier (non-industry specific),
since most small businesses will use one of these editions. Also, once you learn how to use
one of these editions, you'll be prepared to use any of the other editions, with the exception
of the online edition. The online edition is a web-based software product, with different, yet
similar features to the editions covered in this book. For a comparison of all editions and
options, see www.quickbooks.com.

QuickBooks Releases

Occasionally, errors are found in the QuickBooks software after the product is released for sale.
As errors are discovered, Intuit fixes the problem and provides program “patches” via the
Internet. Each patch increases the Release Level of the QuickBooks application. To see what
release level of the software you have, press Ctrl+1 (or F2) while QuickBooks is running. At
the top of the window, you will see the QuickBooks product information including the release
level.

Product Information

Product  QuickBooks Accountant 2013 Release R1P

Figure 1-1 Product information window showing version and release

This book is based on QuickBooks Premier 2013 release R1P. If you have a newer (higher)
release, you may see some slight differences compared to the screens in this book, but most
likely you won't see any differences.

To patch your software with the latest maintenance release, download this release by selecting
the Help menu and then selecting Update QuickBooks. Follow the instructions on these
screens to download and install maintenance releases in QuickBooks via the Internet.

Accounting 101

Before we begin learning how to use QuickBooks, let’s look at some of the background and
key concepts of the accounting process.

Accounting’s Focus

Accounting’s primary concern is the accurate recording and categorizing of transactions so
that you can produce reports that accurately portray the financial health of your organization.
Put another way, accounting’s focus is on whether your organization is succeeding and how
well it is succeeding.

The examples in this book are about a for-profit company called Academy Photography, but
similar needs for information and tracking rules apply to not-for-profit organizations.

The purpose of accounting is to serve management, investors, creditors, and government
agencies. Accounting reports allow any of these groups to assess the financial position of the
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organization relative to its debts (liabilities), its capabilities to satisfy those debts and continue
operations (assets), and the difference between them (net worth or equity).

The fundamental equation (called the Accounting Equation) that governs all accounting is:
Assets = Liabilities + Equity, or Equity = Assets - Liabilities.

Accounts, Accounts, Everywhere Accounts

Many factors go into making an organization work. Money and value are attached to
everything that is associated with operating a company — cash, equipment, rent, utilities,
wages, raw materials, merchandise, and so on. For an organization to understand its financial
position, business transactions need to be recorded, summarized, balanced, and presented in
reports according to the rules of accounting.

Business transactions (e.g., sales, purchases, operating expense payments) are recorded in
several types of ledgers, called accounts. The summary of all transactions in all ledgers for a
company is called the General Ledger. A listing of every account in the General Ledger is called
the Chart of Accounts.

Each account summarizes transactions that increase or decrease the equity in your
organization. The figure below shows a general picture of the effect your accounts have on the
equity of your organization. Some accounts (those on the left) increase equity when they are
increased, while others (those on the right) decrease equity when they are increased.

Capital Equipment
—>

Inventory E Loan Interest
Cash Q
U Rent
Investments I
T Wages

So let’s return to the Accounting Equation. To understand the accounting equation, consider
the following statement. Everything a company owns was purchased by funds from
creditors or by the owner’s stake in the company.

Account Types and Financial Reports

Each account in the general ledger has a type, which describes what kind of business
transaction is stored in that account. There are primarily five types of accounts: asset, liability,
equity, income, and expense. Assets, liabilities, and equity accounts are associated with the
Balance Sheet report which is used to analyze the net worth of a business. The income and
expense accounts are associated with the Profit and Loss report (also called Income
Statement) which is used to analyze the operating profit or loss for a business over a specific
time range (month, quarter, year, etc.).

The Balance Sheet report preserves the fundamental accounting equation - Total assets
always equal the total liabilities plus equity, between the accounts. This means that the
total of the assets (which represent what the company “owns”) is always equal to the sum of
the liabilities (representing what the company owes) plus the equity (representing the owner’s
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interest in the company). Although income and expense accounts are not directly shown in
the accounting equation, they do affect this equation via the equity account as shown below.

The income and expenses are tracked throughout the year as business transactions occur and
are totaled at the end of the year to calculate Net Income (or Loss). Net income (total
revenues minus total expenses) increases the owner’s equity in the business, and net loss
(when expenses exceed revenues) decreases the owner’s equity in the business. Thus the
Income and Expense accounts indirectly affect the Equity component of the Accounting
Equation of Assets = Liabilities + Equity, where Equity increases or decreases each year
depending on whether the year’s income exceeds expenses or not.

At the end of the year, the balance of each income and expense account is reset to zero so
these accounts can track the next year’s transactions.

Double-Entry Accounting

Double-entry accounting is the technique that makes the Accounting Equation work. It divides
each account into two sides. One side is a record of transactions that increase the account and
the other side is a record of all transactions that decrease the account. One side (the left side)
is for debits, and the other (the right side) is for credits. Depending on the type of account, a
debit might increase the account or decrease it. The same is true of credits. Therefore, debits
are not always bad and credits are not always good. They are just part of the system of
accounting. However, the rule of double-entry accounting is that total debits must always
equal total credits. Every transaction creates a debit in one or more accounts and a credit in
one or more accounts. If the debits and credits for any transaction are not equal, the
transaction has an error or is incomplete.

Accounting Behind the Scenes

Recording and categorizing all of your business transactions into the proper accounts,
summarizing and adjusting them, and then preparing financial statements can be an
enormous, labor-intensive task without the help of a computer and software. This is where
QuickBooks comes in. QuickBooks focuses on ease of use and hiding accounting details. To
make all this possible, QuickBooks uses components like accounts, items, forms, registers, and
lists, which are discussed later in the chapter. Familiar-looking forms such as invoices, checks,
and bills are used for data entry. As you enter data in forms, QuickBooks handles the
accounting entries for you. Thus business owners can use QuickBooks to efficiently run a
business without getting bogged down with the debits and credits of accounting entries.

QuickBooks also handles double-entry for you. Every transaction you enter in the program
automatically becomes a debit to one or more accounts and a credit to one or more other
accounts, and QuickBooks won't let you record the transaction until the total of the debits
equals the total of the credits. This means you can create reports that show the transactions in
the full double-entry accounting format whenever you need them, allowing you to focus on
the business transaction rather than the debits and credits in the General Ledger.

Cash or accrual method, as discussed in the next section, is handled in QuickBooks as a
simple reporting option. You can create reports for either cash or accrual basis regardless of
the method you use for taxes.

As the book introduces new transactions types (e.g., Invoices, Bills, or Checks), the text will
include a section called “The accounting behind the scenes.” For example, when you first
learn about invoices you will see the following message:
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The accounting behind the scenes:

When you create an Invoice, QuickBooks increases (with a debit) Accounts
Receivable and increases (with a credit) the appropriate income account. If
applicable, Invoices and Sales Receipts also increase (with a credit) the sales tax
liability account.

Letting QuickBooks handle the accounting behind the scenes means you can focus on your
organization and identify the important factors that will help you succeed. Once you identify
these factors, you can use QuickBooks to monitor them and provide information that will
guide you in managing your operations.

Accounting for the Future: Cash or Accrual?

Another critical aspect of accounting is managing for the future. Many times, your
organization will have assets and liabilities that represent money owed to the company, or
owed to others by the company, but are not yet due. For example, you may have sold
something to a customer and sent an invoice, but the payment has not been received. In this
case, you have an outstanding receivable. Similarly, you may have a bill for insurance that is
not yet due. In this case, you have an outstanding payable.

An accounting system that uses the accrual basis method of accounting tracks these
receivables and payables and uses them to evaluate a company’s financial position. The
accrual basis method specifies that revenues and expenses are recognized in the period in which
the transactions occur, rather than in the period in which cash changes hands. So to help you
manage the future and to more accurately reflect the true profitability of the business in each
period, assets, liabilities, income, and expenses are entered when you know about them, and
they are used to identify what you need on hand to meet both current, and known, future
obligations.

In the cash basis method, revenues and expenses are not recognized until cash changes hands.
So revenue is recognized when the customer pays, and an expense is recognized when you
pay the bill for the expense. In most cash basis systems, you must use an outside system to
track open invoices and unpaid bills, which means you cannot view both cash and accrual
reports without going to several places to find information. However, in QuickBooks, you can
record transactions such as invoices and bills to facilitate accrual basis reporting, and you can
create cash basis reports that remove the receivables and payables with the same system.

Although certain types of organizations can use the cash basis method of accounting (many
are not allowed to do so under IRS regulations), the accrual method provides the most
accurate picture for managing your organization. You should check with your tax accountant
to determine which accounting method — cash or accrual — is best for you.

Academy Photography Sample Company

Throughout this book, you will see references to a fictitious company called Academy
Photography. Academy Photography is a photography studio that also sells camera
equipment. This company uses QuickBooks for its accounting and business management.
Academy Photography may not be exactly like your business; however, the examples in this
text that focus on Academy Photography are generic enough to guide you on your own use of
QuickBooks.

Academy Photography has two locations, one in San Jose and another in Walnut Creek. In
order for management to separately track revenue and expenses for each store, Academy
Photography uses Classes in QuickBooks. As you proceed through the book, you'll see how
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each transaction (bill, check, invoice, etc.) is tagged with what Class it belongs to, so that later
you can create reports like Profit & Loss by Class. Classes can be used to separately track
departments, profit centers, store locations, or funds in any business.

Academy Photography also needs to separately track revenue and expenses for each job it
performs. When a customer orders a photo shoot, Academy Photography needs to track all of
the revenue and expenses specifically related to that job so it can look back and see how
profitable the job was. This concept is called job costing, and many different businesses need to
track jobs in similar ways.

As you think through the examples with Academy Photography, ask yourself what parallels
you see to your own organization. Certainly, areas such as salaries, supplies, equipment, and
others will be appropriate for your setup, but the names and specifics of the accounts, items,
lists, and forms will probably be different.

About QuickBooks Files

Before using QuickBooks, it is important for you to understand how QuickBooks files are
structured and used. QuickBooks has three primary types of files described below. In the
filename the letters after the dot (.) are referred to as the file extension and are used by
Microsoft Windows to associate files with the appropriate application program. All file types
can be opened using the Open or Restore Company option from the File menu.

1. Working Data Files — These files are used to enter transactions and create reports. The
file extension for these files is .QBW.

2. Portable Company Files -These files are a compact version of the company data files and
are used to transport the file between computers or send as an email attachment. The
file extension for these files is .QBM. These files should never be used to back up your
QuickBooks data. These files must be “Restored” to a working data file to be used.

3. Backup Files -These files are a compressed version of the company data files and are
used as backup to safeguard the information. The file extension for these files is .QBB.
These files cannot be used directly within QuickBooks and must be “Restored” to
working data file format.

This means, if you name your company file ABC, QuickBooks will store the working data file
on disk as “ABC.QBW.” When you back up your company file using the QuickBooks Backup
function, QuickBooks will store your backup file with the name “ABC.QBB.” If you create a
portable data file using the QuickBooks Portable file creation function, the portable file
“ABC.QBM"” will be created and stored on the disk.

Important:

Each file type has a specific purpose and should be used accordingly. Working
data files are used to enter data and run reports, backup files are used to
safeguard the data, and portable files are compressed files used to transport data
via the Internet where smaller files transfer faster.

Creating a New File

There are four ways to create a new QuickBooks file, Express Start, Detailed Start, Comparny
Based on an Existing Comparny, and Conversion from Other Accounting Software. Although it is
possible to create a QuickBooks file relatively quickly using Express Start, we recommend
utilizing a 12-Step process for creating a file to properly set up accounts and account balances.
We have placed the chapter that explains file setup later in the book so you will be able to
utilize knowledge gained in earlier chapters. You can learn more about file setup in our File
Setup chapter starting on page 357.
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Opening a QuickBooks Sample File

For learning purposes, QuickBooks provides sample data files that allow you to explore the

program. To open a sample data file, follow these steps:
COMPUTER PRACTICE

Step 1. Launch the QuickBooks program by double-clicking the icon on your desktop or
selecting it from the Windows Start menu.
Step 2. When QuickBooks opens, you will either see the No Company Open window (Figure
1-2) or the last working data file used.
No Company Open window is displayed if you are opening QuickBooks for the first
time or if you closed the working data file before exiting in your last session. By
default, the last working data file used will open, if you closed the QuickBooks
program before closing the file.
No Company Open
Select a company that you've previously opened and click Open

Edit List

LOCATION: C:Useratiis Previously used files are

[_L‘;]_J J.,:-J "‘J shown here. To open a
- = - . file, select from the list
Create a Open or restare an Open a and click OPEN button
new company existing compan sample file: 3

Location of highlighted
file on your computer or
network.

Figure 1-2 No Company Open window

Step 3. If you don’t see the No Company Open window (Figure 1-2), select the File menu,

and then select Close Company. Click No if you are prompted to back up your file.
Step 4. Click Open a Sample file button and select one of the files from the list. The selected

sample file will open with the QuickBooks Information screen (see Figure 1-3).

Step 5. Click OK to continue.

This is the QuickBooks sample file. Use it as an example or for practice while
L' learning QuickBooks.

While using this file QuickBooks will set today's date to 12/15/2017

Do not use this file as your company file.

Figure 1-3 Sample File Information Screen

Step 6.

The sample file you selected will open and then the Accountant Center screen (Figure
1-4) may be displayed. This appears by default when you open a file; however, if you
do not want to see it appear next time you open this file, you can uncheck the Show
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this window at startup box.

Close this window by clicking the X in the top right corner of the Accountant Center.

Accountant Center
,_{55 Tools

QuickBooks File Manager
Chart of Accounts

Add'Edit Multiple List Entries
Fixed Asset ltem List

Cusiomze

Client Data Review
Warlang Trial Balance
Reclassify Transactions

Fix Unapplied Customer Payments and Credits

Memorized Reports

SELECT GROUP | Accountant B

Balance Shest
General Ledger

Use Ragister Write OfF Invoices Journal Entries Entered Today
Make General Journal Entries Fux Incomrectly Recorded Sales Tax Profit Loss
Trial Balance
TIP: Save time doing write up by using ihe new Baich Enter Transactions feaiure
= E
Display Group QuickBooks Statement Writsr

& Reconciliation

Refresh

ACCOUNT LAST RECONCILED  RECONCILED BALANCE  CURRENT BALANCE n Accountant Updates
Checking 71,452 58 46,969.10

Savings 4341019 1791019 MESSAGE

Patty Cash 0.00 500.00 Ses What's New in QuickBooks Accountant 2013
QuickBooks Credit Card 25.00 94.20 Mew for QuickBoaks ProAdvisors in 2012-13
CalOil Credit Card 435.30 382.62 Maost Common QuickBooks Mistakes: Credit Card

Reconcile Ermors

The Latest In Cloud Computing. A White Paper

[¥ Show Accountant Center when opening a company file

Log into my QuickBooks ProAdviser Account

Figure 1-4 Accountant Center

Opening Portable Company Files

Portable Company Files are compact company data files that can be easily transported. The
exercise files that accompany this book are Portable Company Files. You will need to open
these exercise files at the start of each chapter and each problem.

When you move a data file from one computer (computer A) to another
(computer B), any data you enter on computer B will cause the file on the
computer A to become “obsolete.” That is, the file on computer B has new data
and there is no way to transfer that new data into the file on computer A, except
by manually entering the data or by replacing the whole file on computer A
with the new file. Therefore, when you copy data files from one computer to
another, you cannot continue to work on the file in both places.

COMPUTER PRACTICE
To open portable files follow the steps below.

Step 1. Select the Open or Restore Company option from the File menu (see Figure 1-5).
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Edit View Lists Favorites Accountant Com

ew Company...
Mew Company from Existing Company File...
Qpen or Restore Company...
Cpen Brevious Company ¥

Figure 1-5 Open or Restore Company

Step 2. QuickBooks displays the Opern or Restore Company window. Select Restore a
portable file (.QBM) and click Next.

Open or Restore Company
What type of file do you want to open or restore?

& Open a company file

« Open aregular company file { gbw)
« Open an Accountant's Copy working file (.qba)

1 Restore a backup copy

« + Restore a backup file (.gbb)
+ Restore files from an online backup

rtable file

“Re create 2 company file thatwas stered as 2 portable file (.qbm)

) Convert an Accountant's Copy Transfer File
+ Select an Accountant's Copy Transfer File ((QBX)
+ Convert it to an Accountant's Copy working file{ QBA) and save il

Figure 1-6 Open or Restore Company window

Step 3. QuickBooks displays the Open Portable Company File window (see Figure 1-7).
Navigate to the location of your exercise files. You may need to ask your
instructor if you do not know this location. Once you are viewing the contents
of correct folder, select Intro-13.QBM and click Open.

Lookin: | |, QuickBooke 2013 Ciaseroom Files - @@ m
= Mame
el lIntro-13.Q8M
Recent Places
Desktop
=l
Libraries
Computer
i:.._
Network
<« -
Fée name: [itro-130EM < [open |
Fies of type: [QusckBooks Portable Company Fées FGBM) ¥ [ Cancel |

Figure 1-7 Open Portable Company File window
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Step 4. Next you will need to tell QuickBooks where to save the working file that will be
created from the portable file (see Figure 1-8). Click Next in the Open or Restore
Company window to continue.

Open or R

@ Where do you want to restore the file?
| e | In the next window, you will choose the location where you want to restore the file. As the
aj file restores, itis converted to a company file with the extension .gbw.

|

Important: If you don't want to overwrite your existing company file, rename the file in the
‘d next window. For example, you may want to add a date orversion number such as

@ mycompanyname-Jan2-2007.gbw or mycompanyname-v2 qbw.

Do you sync your company file with your online services?

You or your accountant may have worked on this backup while the syncwas
suspended. Ifthis is the case, you should overwrite your existing company file in the
next window. Sync will then be resumed.

Figure 1-8 Open or Restore Company Location

Step 5. The Save Company File as window displays (see Figure 1-9). Ask your instructor or
choose a location to save the file. When you have navigated to the appropriate
folder, click Save.

Savemn: | || GuickBooks 2071 Classon Files « @ ¥ e @~

MName

Y
s Mo tems match your search,
Recent Places

- [var 1308w

el

i,

Save 3z bypa: G-ABwk: Fies T QGEW)

Figure 1-9 Save Company File as window

Step 6. If asked to update your company files, click Yes.
Step 7. Once the Intro-13.QBW company file finishes opening, you will see the Home page.
Restoring Backup Files

When working with important financial information, creating backup files is a crucial
safeguard against data loss. Every business should conduct regular backups of company
information. QuickBooks has useful tools to automate this process.
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In the event of an emergency, you may need to restore lost or damaged data. For example, if
your computer’s hard drive fails, you can restore your backup onto another computer and
continue to work.

Important:

Restoring does not add information to your file, but replaces your data with a
new file that has all of the data you had when you created the backup.
Consequently, you should only restore a file when you are certain it is necessary.

Portable files should never be used as a substitute for backup files. Backup files are larger than
portable files and hold more information about the company. When you create a backup file,
QuickBooks resets a log file that tracks all the changes made to the file between backups.
Intuit Customer Support can use this file to troubleshoot and help restore information in case
you need to recreate your current company information from a restored backup.

In general, there are two main uses for QuickBooks backup files.

1.  When you transfer files between computers and need more information than is
contained within the portable file (for example, between accountant and client).
2. To recover damaged or lost data files.

Note:

In addition to the Backup and Restore process which moves the complete
QuickBooks file between computers, QuickBooks also has a feature called the
Accountant’s Copy. This feature enables an accountant to review and make
corrections to a special copy of the client’s company file while the client
continues to work. Then the client can merge the accountant’s changes back into
the original file. See the QuickBooks Help Index for information on this feature.

Backing up Your Data File

Backing up your data is one of the most important safeguards you have to ensure the safety of
your data.

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY.

1.  To back up your company file, select Create Copy from the File menu.
2. Choose Backup copy from the Save Copy or Backup window. Click Next.

3. You are given the option to save the backup to a local area, such as a removable hard
disk, or an online backup using a fee-based service available from Intuit (see Figure
1-10). Online backup is a good option for many companies.

Choose Local backup and click Next.
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What type of file do you want to save?

emiy

)

3

® Backup copy

of accidental loss or damage 1o your data
' Portable company fike

tempaorarily mave to anather computer

) Accountant's Copy

adjusiments tal you can import into your file |ater

Accountant's Copy = Sand 1o Accountant

Help me choose

Back Finish

Create a backup copy of everyihing you need to re-create yousr company file in case

Create a compact version of your company financial data thal you can e-mail or

Create a compact version of your company file. Your accountant will use it o make

o To send thes file to an Intuit wab server, click Cancel now and go 1o File =

Cancel

Figure 1-10 Save Copy or Backup window

4.  The Backup Options window is displayed (see Figure 1-11). Under the Local backup only

section, click the Browse button.

Use Tis window 10 581 Gafault options for your manual and aulomalic Batkups
LOICAL RAGHUP OHLY

Tell us where bo save your backup copses (required)

|| Bromse.
# Add the date and ime of the backup to the Sle name (recommanded)
# Limit e number of backup copies in this folderte 3
OMLINE AND LOCAL BACKUP
¥ Bemind me fo back up when | close my company file every 4 tmes

Seled an oplion % verily Ihat pour company @ata is OK (nat is, not conupte @) when
YOU Bave

® Complete verficalion (recommended)
O Quicker verficalion

) Hovenfication

Figure 1-11 Backup Options window

Huolp me choose

Cancel Help

5. Select the folder where you want to store your backup file (see Figure 1-12). You should
store the backup files on a safe location, preferably on a different drive than your
working data file. That way, if the drive with the working file is damaged, the backup

will still be available.
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— mia v

Figure 1-12 Backup options Browse for Folder window

6. When finished, click OK.

7. The Create Backup window is displayed (see Figure 1-13). You can save a backup now,
schedule future backups, or both. Select Only schedule future backups and click Next.

1 When do you want io save your backup copy?
| _I © Save jl now
) Sawe il now gnd schedule Rilure backups

@ Only gchedule future backups

Mofe: B you are saving your backup copy to a remaovable storage device such as a CD
or L'SB flash drive, insert ihe CD or conned ihe device now.

Figure 1-13 Create Backup window

8. In the Create Backup window, select New under the Schedule Backup area.
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(T,
i - -

| I BACK UP AUTOMANCALLY.

Backup copies will be saved

Click Options 10 view of change where the automatic

When do you want to backup your company flle?

BALK UP OM A SCHETHAE
@ Click New 1o schedule regular backups of your company e,

Ramove

Save backup copy gulomaticaly when | close my company Ml every

Options

Help

times

Cancel

Figure 1-14 Create Backup window

9.  The Schedule Backup window appears (see Figure 1-15). Enter a descriptive name for the
backup, the location of the folder to contain the backups, and the time when the

backup file will be created.

O SCRIE TWE BACKUP TASK YOU YEANT TO SCHEDULE
Descripdon yongay Might Backup

Locaton G

Hurnber of backup copies 1o keep

Stattime 9 00 - And -

L

SELECT MMl TIME AND DAY YOU WANT TO S0 TWE BACKUP®

Run this task every 1 = ‘weskson

¥ Monday Tuesday Weonesday
Thursday Encay Saturday
Sunday Store Password._.

Figure 1-15 Schedule Backup window

10.  When finished, click OK to close the Schedule Backup window
11. Click Finish to close the Schedule Backup window.
12. If necessary, click No, Thanks for the offer to try Online Backup.
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Restoring a Backup File

To restore a QuickBooks backup file, follow these steps.

DO NOT PERFORM THESE STEPS. THEY ARE FOR REFERENCE ONLY.

1. Select the File menu and then select Open or Restore Company.
2. Choose Restore a backup copy from the Open or Restore Company window.

3. In the Open or Restore Company window you can specify whether the file is stored locally
or through Intuit’s fee-based Online Backup service. Choose Local backup and click
Next.

4. The Open Backup Copy window allows you to specify where the backup file is located (see
Figure 1-16). Navigate to the folder that contains the file, select it and click Open.

Lookmn: | | GusckBooks 2013 Clsssmom Fiss - @F O
= Hame =
= (Hitniro-13.088
Recent Places
Deskbnp
T
RLibraries
Comparter
"?‘L
Mubwaork
-
Fi name. rire-13.068 [l T
Fles of type: ‘QEW Backup ["OEE) = Larce

Figure 1-16 Open Backup Copy window

5. The Open or Restore Company window displays. Click Next.

6.  The Save Company File as window allows you to specify where to restore the working
files (see Figure 1-17). Navigate to the appropriate folder and click Save.

QuickBooks will then restore your backup file in the folder you specified. When
QuickBooks restores the file, it creates a .QBW file.

Savein | | OuickBooks 2013 Clasarcom Fes - @i >3
A Mame .
-~p No iterms match your sesrch.
Recent Places
Desktop
Fe
Librares
Computer
Hetwork
-
File rama - 13 GEW e L S |
Save aatype: ChsckcBocks Fles [ OBW) > Corcel |
e |

Figure 1-17 Save Company File as window
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7. If you receive the warning message shown in Figure 1-18, it means that QuickBooks is
attempting to overwrite an existing file on your computer. If this is your intention, click
Yes. If you do not intend to replace an existing file, click No and change the name of
the restored file. You will be asked again to key in the word “Yes” so you don’t
accidentally overwrite a needed file.

'l. Intre-13.QBW already ensts.

L35 po you want to replace it?

Figure 1-18 Restore To warning

Tip: If you are not sure if you should replace a file, change the name of the
restoring file slightly. For example Intro-13 (version 2).QBW would keep the file
from being overwritten and indicate to users the most recent version.

8.  After completion, a window displays that the new file has been successfully restored (see
Figure 1-19).

0 Your data has been restored successfully.

Figure 1-19 After restoring backup file

Note: When you restore a data file, depending on today’s date, you may see one
or more “Alerts” for learning to process credit cards, pay taxes, or similar
activities. Click Mark as Done when you see these alerts.

Entering Transactions in QuickBooks

Whenever you buy or sell products or services, pay a bill, make a deposit at the bank, or
transfer money, you need to enter a transaction into QuickBooks.

Forms

In QuickBooks, transactions are created by filling out familiar-looking forms such as invoices,
bills, and checks. As you fill out forms, you choose names from Iists such as the customer list,
the item list, and the account list. When you finish filling out a form, QuickBooks
automatically records the accounting entries behind the scenes. Most forms in QuickBooks
have drop-down lists to allow you to pick items from lists instead of spelling the name of a
customer, vendor, item, or account. The Pop-up calendar is another feature available on
forms, which allows you to pick a date on the calendar rather than entering the whole date.

COMPUTER PRACTICE
Step 1. Click the Enter Bills icon on the Home page Vendors section (see Figure 1-20).
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VENDORS

= "y
Purchase Receive
Orders Inventory

©

Enter Bills

Figure 1-20 Enter Bills on the Home page

Step 2. Click the Previous button on the Enter Bills window until you see the previously
entered bills in Figure 1-21.
Step 3. Click the down arrow next to the vendor field to see the dropdown list for vendors.
= Enter Bills =
Main Reports HoaA
B B % Beeercn 5§ B & B @&
Al ew  Save Delete aMemonze Pr:nt Atl‘r:em Salg:l ?r:‘:; g,l:;; Recalculate Paa‘ll‘c
@® = © crep| Previous [@ BILL RECEVED | ”(7"‘}/]} V R('f\
@ar @cR | I - e | s f\““(ﬂ Wy
- Drop-down list | e WQ}\’{:‘%
Bill | +11
VEWDOR  Rodriguez Rentals - DATE 01/30/2017 B ; SUMMARY '\
LV || Phone 925-555-3479 y
DDRESS Rodriguez Rentals i e .J Open balance 750.00
ﬁmf@iﬁ,ﬂmm AMCUNTDUE 7R000 g P;sm be received n{i\
BILL DUE 02(14/2017 @ .2 !‘C
TERNS Net15 - NZ 1)\ I—l /kz) i:
MEMO Lighting Rental e HIStOr}' pane ;?J ty;
Expenses $750.00 | ltems $0.00 l; RECENT TRANSACTION E 'N
ACCOUNT \am:u\r . F.IEF.I# i CUSTOMER:)... ! BILL... | CLASS % Loading. ;\}
62600 - Equipment R... \muy San Jose * ; 'i'.
7|
LJ S HOTES ¢ |
Save & Close Revert E\AAE’_L”'B_LTE - N o -.%
Figure 1-21 Bill form
Step 4. Click the calendar icon next to the date to see the calendar pop-up menu.
Step 5. When finished exploring, click the Revert button which will return the transaction to
the last saved state.
Step 6. Close the Enter Bills window.

By using forms to enter transactions, you provide QuickBooks with all of the details of each
transaction. For example, by using the Enter Bills form in Figure 1-21, QuickBooks will track
the vendor balance, the due date of the bill, the discount terms, and the debits and credits in
the General Ledger. This is a good example of how QuickBooks handles the accounting
behind the scenes, and also provides management information beyond just the accounting
entries.

Lists

Lists are one of the most important building blocks of QuickBooks that makes the program
very powerful and efficient. Lists store information which is used again and again to fill out
forms. For example, when you set up a customer’s name, address, account number, etc.
QuickBooks can use the information to automatically fill out an invoice. Similarly, when an
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Item is set up, QuickBooks can automatically fill in the Item’s description, price, and
associated account information. This helps speed up data entry and reduces errors.

Note:

There are two kinds of lists — menu-based and center-based. Menu-based lists
are accessible through the List menu and include the Item list and Terms lists.
Center-based lists include the Customer Center and Vendor Center, discussed on
page 23.

Lists can be viewed by selecting an icon from the Home page (for example, the Items & Services
button), choosing a menu option from the Lists menu, or viewing a list through one of the
various QuickBooks Centers.

Accounts

QuickBooks provides the means to efficiently track all of your business transactions by
categorizing them into accounts. The Chart of Accounts is the list of these accounts.

COMPUTER PRACTICE
Step 1. To display the Chart of Accounts, click the Chart of Accounts icon on the Home page.

Alternatively, you could select Chart of Accounts from the List menu, or press
Ctrl+A.

Step 2. Scroll through the list. Leave the Chart of Accounts open for the next exercise.

By default, the Chart of Accounts is sorted by account number within each account type (see
Figure 1-22). The Name column shows the account names that you assign; the Type column
shows their account type; the Balance Total column shows the balance for asset, liability, and
equity accounts (except Retained Earnings), and the Attach column shows if there are
attached documents.

MAME : - F TaTA
[+ 10100 Chacking i 1 (T 1156200

= 10200 - Money Mz Account type znk 12,100.00
= 10300 - Savings | determines the type of |3anc 500.00
10200 - Journal transaction saved. ank 0.00
+ 11000 - Accounls Recewable 456320
= 12000 - Undeposiled Funds . Ofher Current Asset 0.00
= 12100 - Imventory Asset Other Current Asset 647223
+» 12800 - Employee Advances Ofner Curent Asset 0.00
« 13100 - Prepaid Insurance Other Current Asset 0.00
+ 15000 - Furnilure and Equipment Fixed Assat 1325000
+ 15200 - Buildings and Improvemants Fixad Assal .00
= 15600 - Land Fieed Asset 0.00
= 15800 - Leasehold Improvements FixedAsset .00
= 16400 - Vehicles FoedAsset 0.00
« 17000 - Accumulated Depreciation Fired Assgl ; -1.225.00
= 18700 - Security Depasits 4 All the accounts with a hss 6l 0.00
= 20000 - Accounts Payabie balance total entry s Payabie 750.00
= 22000 - National Bank V1A o Card 0.00
have a register I _

» 24000 - Payroll Liabilties urrent Liabdity 363.00

+24010 - Company Payroll Taxes Payable Other Current Liability 368.00

+24020 - Employes Payroll Taxes Payabls Other Cument Liability 0.00

+ 24030 - Other Payroll Liabilities Otner Current Liablliry .00
= 24200 - Line of Credit Other Current Liabiliy 6,700.00

Account ¥ Activities * Reports ¥ Attach

Figure 1-22 Chart of Accounts List
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Registers

Each asset, liability, and equity account (except Retained Earnings) has a register. Registers

allow you to view and edit transactions in a single window. Income and expense accounts do
not have registers; rather, their transactions must be viewed in a report.

COMPUTER PRACTICE

Step 1.

To open the Checking account register, double-click on 10100 Checking in the Chart

of Accounts list.

Step 2. The Checking register opens (see Figure 1-23). Scroll through the register.
= k 1 - OO ™
@ Goten. | & Print. | B Edit T, ion [ QuickRepert [2) Dewnload Bank Statsment
0IMER01T | 327 Orlands Properties 3200 .00 14 483 08 A
CHK EF100 - Rent Expe Ren Tor San Jose

0 MSE01T 328 ACE Bupply 128,60 14,354 43
CHE E4300 - Ofice Sup Acch? 43-234

0202017 6003 Wong & Son Video 142.00 14,212.48
BILLPMT 20000 - Acceunts F Videa Production C

01202017 | 6004 ACE BUpply 12348 14.089.00
BILLPMT -split- Acch 43-234 v

Solts EMDING BALANCE 11 ,58200
i-lina
Sl pate, Type, HumberRel - Reslore

Figure 1-23 Checking account register

Step 3. Close the Checking account register by clicking the close button in the upper right
corner.
Step 4. Double click the 40000 Services account. This is an /ncome account.
Step 5. Instead of opening a register, QuickBooks opens a report (see Figure 1-24).
Step 6. If necessary, change the Date field to All.
Step 7. Close the report.
Customize Report Share Template Memonze Print E-majl v Excel v Hide Hegder Refregh
Dates Al ~ From o To 8 SortBy Default -2
Academy Photography - Intro Chapter
Account QuickReport
Accrual Basis All Transactions
- Type o Date + Num = HName . Memo . Split o Amount o
40000 - Services
1 nvoice 1M21206 4003 Anderson Wedding Planners. 2 Hr indoor Session wit.. 11000 - Acco 19000 4
Invoice 0105207 2017 Cruz, Maria:Branch Opening 4 Hr Quidoor Session, 2. 11000 - Acco 38000
Ivoice DINS2MT 2017 Cruz, Maria:Branch Opening 4 Hr Ouidoor Session, 2 11000 - Acco 150.00
Invoice ovoeRMT 2017, Cruz, Maria:Branch Opening 4 Hrs Addtional Phalogr. 11000 - Acco 50000
voice 01oePmMT 2017 Mason, Bob 3 Hr Indoor Session, Re.. 11000 - Acco 28500
hvoice 01NSE01T 2017 Mason, Bob 3 Hr Indoor Session, Re: 11000 - Acco 350,00
Invoice 0N3zMT 27 Cruz, Naria:Branch Opening 4 Hr Indoor Session and 11000 - Acco 38000
voice ginamT 2017, Cruz, Mara:Branch Opening 4 Hr indoor Session and . 11060 - Acco S00.00
Total 40000 - Services 2 805 00
TOTAL 2,805.00

Figure 1-24 Services Account QuickReport — your screen may vary
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Step 8. Close the Chart of Accounts.

Items

Items are used to track the detail behind QuickBooks transactions. Since every business has its
own unique set of products and services, QuickBooks can be customized to your business by
creating Items for each service or product your company buys or sells.

QuickBooks allows twelve Item types for Items associated with buying and selling: Service,
Inventory Part, Inventory Assembly (Premier and Enterprise Solutions only), Non-inventory Part,
Fixed Asset, Other Charge, Subtotal, Group, Discount, Payment, Sales Tax Item, and Sales Tax
Group.

When you define Items, you associate [tem names with Accounts in the Chart of Accounts.

This association between Item names and Accounts is the “magic” that allows QuickBooks to
automatically create the accounting entries behind each transaction.

For example, Figure 1-26 displays the Item list. The [tem, Camera SR32, is associated, or
linked, to the Sales account in the Chart of Accounts. Every time the Camera SR32 Item is
entered on an invoice, the dollar amount actually affects the Sales account in the Chart of
Accounts.

[tems are necessary because to use a sales form in QuickBooks (e.g., invoices and sales
receipts), you must use Items. On an invoice, for example, every line item will have a
QuickBooks Item which may represent products, services, discounts, or sales tax.

COMPUTER PRACTICE

Step 1. To see what Items are available in the file, click the Item & Services icon on the
Home page in the company section (see Figure 1-25).

Alternatively, you could select Item List from the Lists menu.

COMPANY
_

Chart of Imventory

Accounts Activities

s &3
[tems & Imtuit
Senvices Loan Finder

Figure 1-25 Items & Services button on Home page

Step 2. Figure 1-26 shows the Item list. Double click the Camera SR32 item.

Introducing QuickBooks — Entering Transactions in QuickBooks
Learn more about the Intuit Education Program:
Intuitaccountants.com/QuickBooksGuide


http://accountants.intuit.com/intuit-education-program/
http://accountants.intuit.com/intuit-education-program/

Intuit QuickBooks Fundamental Learnings Guide 2013
by Doug Sleeter

Introducing QuickBooks — Entering Transactions in QuickBooks 21
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» Quidoor Photo Sess . Ouldoor Phioto Session Sendce 40000 - Senices 95.00
« Pholag Phatog Sendce 40000 - Senices 125.00
» Relouching Photo redouching sendces  Sendce 40000 - Services 95.00
« Camera SR22 Supra Digital Camera SR32 | inveniory Past 45000 - Sales ] o 69599
+ Case Camera and Lens High m_ inventory Pam 45000 - Sales 24 ] 79.99
» Frame SaT Picture Frame - § x 7 Metal. . invenlory Pa 45000 Sales 22 o 590
»Lens Supra Zoom Lens inventory Past 45000 - Sales 7 0 32409
= Fllm 36C 200A3A, 35 Color Film NorHmventody Pant 45000 - Sales 1235
= Premium Photo Pac_. Premium Package of Phol . Mondmventosy Part 45000 - Sales B85.00
+ Standard Photo Pac . Standard Package of Photo_ Mon-meniony Part 45000 - Sales 55.00
+ Bad Dedt Ead Dedt - Wite off Omer Charge 60300 - Bao Debts 0.00
+ Bounce Chg Retum Check Fes Omer Chargs 45000 - Sales 0.00
« Conira Costa Contra Costa County Sales_ Sales Tax tem 25500 - Sales Tan Payable a.25%
* Qut of State Out-of-state sale, sxempt fr_ | Sales Tax tem 25500 - Sates Tax Payable 0.0%
» Sania Clara Santa Clara Counly Sales . Sales Tax ltem 25500 - Sales Tax Payable 8.25%

Mo * Acivities * Reports * Excedl ¥ Allach

Figure 1-26 Item List

Step 3.
Step 4.

Step 5.

If the New Feature window opens, click OK.

The Edit Item window opens (see Figure 1-27). Notice this item is linked to the Sales
account, Every time this item is entered on an invoice, it changes the Sales account.

Close the Edit Item and Item List windows.

T™YPE

Inventary Pant

Camera SR32
UNIT OF MEA SURE

Enabile...

Rem NameNumber

[ Substem of

Use for goods you purchase, rack as inventory, and resell

Manufacturers Part Number

PURCHA SE INFORMATION

Description on Purchase Transactions

SALES WNFORMATION
Description on Sales Transactions

L Itemn is Inactive

OK
Cancel
Noles
Custom Fields

Spedling

Supra Digital Camera SR32 Supra Digital Camera SR32
The Camera SR32
item is linked to the
Cost 450.00 Sales Price 59599 Sales account.
COGS Account 50000 - CostofGoods.. ~  TaxCode Tax -
Preferted vendor . |nw@5]ﬁ Sales D
INVENTORY INFORMATION
Ayerage
AssetAccount Reorder Point  OnHand  Cost OnPO.  OnSales Order
12100 - Inventory Assat - ] 450.00 0 0

Figure 1-27 Camera SR32 Edit Item window — your screen may vary

Calendar

You can view transactions on a Calendar. The calendar displays transaction on the Entered date
and the Due date.
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Note:

The Entered date is not literally the date when the transaction is entered into
QuickBooks. It is the transaction date that is input on the transaction form. If
you create an invoice on January 5", 2017 and enter the date 01/06/2017 in the
date field, the invoice will show on January 6'", 2017 on the Calendar.

& & January 2017 Today B eecraane @ | 950w | b Tearasrsom
® Upcoming Mext T days (0)

1 2 3 4 Emomat |1) § Estered 13 5 Erteese 1, 7 - T0 DO 0
= TRANSACTIONS M)

i1

P Due Past 60 days [0)

00O
« TRARSACTIONS §2)

B Estere (1 10 1 12 13 Estered (1 14
B
[
] 8 17 Duelf

Maon Beo THeAT 2017104 LS =2 0T

Figure 1-28 QuickBooks Calendar

COMPUTER PRACTICE

Step 1. Click the Calendar icon on the Company section of the Home page.

Step 2. The Calendar window opens (see Figure 1-28). When finished, close the Calendar
window.

QuickBooks User Interface Features

QuickBooks provides a number of shortcuts and aids that assist the user in entering
information and transactions. You should become familiar with these features so you can get
to a task quickly.

There are various methods of accessing the data entry windows: the Home page, Snapshots,
Menus, QuickBooks Centers, Icon Bar, and Shortcut Keys.

Home Page

As soon as you open a company file, QuickBooks displays the Home page (Figure 1-29). The
Home page is broken into five sections — each dealing with a separate functional area of a
business. These areas are: Vendors, Customers, Employees, Company, and Banking. Each area
has icons to facilitate easy access to QuickBooks tasks. The Home page also displays a flow
diagram showing the interdependency between tasks.
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Figure 1-29 QuickBooks Premier 2013 Home page

To start a task, just click on its related icon on the Home page. If you close the Home page, it
can be opened by clicking on the Home icon on the Icon bar.

Centers

There are several Centers in QuickBooks, such as the Customer Center and Vendor Center, as
well as many others. Centers are organized to give pertinent information in one place.

Customer, Vendor, and Employee Centers are very important since they provide the only way
to access the Customer list, Vendor list, and Employee list. These three lists are referred to as
the Center-based Lists. These Centers summarize general information and transactions in the
same area. For example, the Customer Center shows the customer balance, their general
information, and all transactions for each customer (see Figure 1-30).

& Yew Comtomer & Job = 5] Wew Transsctions = (5 Brid + [[] Ezesl v [0 Word v B Comections Centar
e ] -
Customer Information 6 # e
At Custmins - ¥
o £08.555.0225 kR pert
Beg Masan ! bmasonggmh oo Ine
« Agagemy Tranin 000 i ! Ineasusl
4026193
+ Andarson Weddl 24984
ndsrson [
sKurar a3 24054 Bod Mason
376 Fine 5L #OE
+'#filsan, Barah 0.0 Margsn HIL, CASSIT
« Bamy, Ran 000
Wao | Diections
# Cruz Maria 1.850.00
» Brasch Ogan 1,850 00
» Eashy Bus nass 02
+ Femg, Tim 000
« Garison, John 000 Trmsacgoss  Conmms ToQo's Motag
iy Paiist 080 seow Al Transacions = noemer Al = oA This Fiscal Vear * DUIEAE - 120012
» Nasan, Bab 117738
T - Thers are iz Fanzachons of ype 4 Transachans”, Aleress by "AIF. in Sl range This Flscal fear
+ Nicandas Cames 113130

Figure 1-30 Customer Center

Other Centers include the Application Center, Online Banking Center, Report Center, and
Document Management Center. These Centers will be addressed later in this book.
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Snapshots

The Snapshots is a single screen summary of different aspects of a company. Charts such as
Income and Expense Trends, Previous Year Income Comparison, and Expense Breakdown are
displayed along with important lists such as Account Balances and Customers Who Owe Moriey.

The Snapshots can be easily customized to show the information that is of most interest to
you and your company.

Company Snapshot

S — B &
Add Content » | Restore Default How do I customize this page? | (&) Printv
Income and Expense Trend Prev Year Income Comparison Customers Who Owe Money
$in 1000s This year-to-date ~ *  |Al M| Quarterly T Customer DueDate « AmtDue
& $in 1000s Mason, Bob 01/17/2017 1,177.36
- 80 Anderson Wedding Planners | 01/20/2017 249.54
Cruz, Maria 01/04/2018 1,950.00
“ Miranda's Corner 01/07/2018 1,191.80
30
20
10 h
X NN NN N B
o

S P M e My s W kg S 0= e o
Ouwrter!  Quarer? OQuarer3  Ouarterd

[ Income W Expense . 2016 . 2017 Receive Payments
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Figure 1-32 Icon Bar

The QuickBooks Icon Bar allows you to select activities and available services by clicking icons
on the bar (see Figure 1-32). For example, you can open the Home page by clicking Home on
the Icon Bar. To modify the contents or position of the icons on the Icon Bar, select the View
menu, and then choose Customize Icon Bar (see Figure 1-33).
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Figure 1-33 Customize Icon Bar

QuickBooks Mobile

You can download a free mobile app for a smartphone that enables you to use several
QuickBooks features when you are not at your desktop computer. Features include accessing
your customers’ contact information as well as creating Estimates, Invoices and Sales Receipts.
As of this printing, QuickBooks Maobile is available for the iPhone, iPad, and Android devices.

QuickBooks Mobile b

QuickRooks Campany (QBO)

it
i"

Figure 1-34 Example Main Menu screen for QuickBooks Mobile

QuickBooks Help
Support Resources

QuickBooks provides a variety of support resources that assist in using the program. Some of
these resources are on the Internet and others are stored in help files locally along with the
QuickBooks software on your computer. To access the support resources, select the Help menu
and then select QuickBooks Help (see Figurel- 1-35). QuickBooks will display answers to
problems you might be having based on your recent activity. You can also enter a question
and QuickBooks will search its Help Content and the Online Community for related answers.
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QuickBooks Help F1
Ask Intuit

What's New

Quick Start Center

Find Training...

> Learning Center Tutorials
Support

Find ALocal QuickBooks Expert

Send Feedback Online 4

Internet Connection Setup
Year-End Guide

Add QuickBooks Services

App CenterFind More Business Solutions
Update QuickBooks...

Manage My License 3

Manage Data Sync »

QickBooks Privacy Statement
About Automatic Update

About QuickBooks Accountant 2013...

Figurel- 1-35 QuickBooks Help Menu

QuickBooks Learning Center

As you begin using QuickBooks, the first thing you see is the QuickBooks Learning Center (see
Figurel- 1-36). This center provides interactive tutorials to help users learn how to use
QuickBooks in common business scenarios. If you have deactivated the Learning Center so
that it does not start once the program is launched, you can always access it by selecting
Learning Center Tutorials from the Help menu.

Quic kB

@ Getting Set Up Gettlng Set Up

ks Learning Genter

New lo Setting up QuickBooks
QuickBooks?
Create a mew company file
Setting up QuickBooks 1:51
g Upgraders: Add the people you do business with 238
Add the products and services you sell 1:51
Add your bank accounts 1:00
% Tracking Money In
Installation

= Set up QuickBooks for multi-user
Tracking Money Out
Ready to learn how to get started?
Watch the tutorials in "New to QuickBooks" to learn how to get around and

l T find what you need.

i Other Topics

Go to QuickBooks

Figurel- 1-36 QuickBooks Help Menu

Certified QuickBooks ProAdvisors

Certified QuickBooks ProAdvisors are independent consultants, accountants, bookkeepers,
and educators who are proficient in QuickBooks and who can offer guidance to small
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businesses in various areas of business accounting. To find a Certified ProAdvisor, select Find
a Local QuickBooks Expert from the Help menu.

Review Questions

Select the best answer(s) for each of the following:

1.

The fundamental accounting equation that governs all accounting is:

a) Net income = Revenue - expenses.
b)  Assets + Liabilities = Equity.
C) Assets = Liabilities + Equity.
d)  Assets = Liabilities - Equity.

Which of the following statements is true?

a) Debits are bad because they reduce income.
b)  Equity is increased by a net loss.

C) Debits - credits = 0.

d) Assets are increased with a credit entry.

Under accrual accounting:

a) A sale is not recorded until the customer pays the bill.
b)  Income and expenses are recognized when transactions occur.
C) An expense is not recorded until you write the check.
d)  You must maintain two separate accounting systems.

QuickBooks is:

a) A job costing system.

b) A payroll system.

C) A double-entry accounting system.
d)  All of the above.

Which is not a method of accessing the data entry screens?

a) Menus

b)  Home page

C) Icon bar

d) Data entry button

Introduction-Problem 1

‘ Restore the Intro-13Problem1.QBM file.

Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.

a) What is the first customer listed on the left of the Customer Center?

Note:

The answer to this first question AAA Services. If you don’t see AAA Services in
the Customer Center, make sure to restore Intro-13Problem1.QBM as directed in the
box above. This book uses specific files for each chapter and each problem. If
you don't restore the correct file, you will have trouble completing the exercises.

b) In the Customers & Jobs Center, single click on Cruz, Maria:Branch Opening.

What is Maria Cruz’s balance?
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C) Click the Date dropdown list above the transaction listing in the right-hand
panel and scroll up to the top of the list to select All. How many transactions do
you see and of what type?

d) Close the Customer Center.

Select Vendors from the QuickBooks Icon Bar. This displays the Vendor Center.

a) Double-click Sinclair Insurance. This opens the Edit Vendor window. What is the
Address? Close the Edit Vendor window.

b) What is the amount of Bill number 5055 to Sirniclair Insurance? (You may need to
set the Date to All as in Step 1.)

C) Close the Vendor Center.

From the Home page, click the Chart of Accounts icon to display the Chart of Accounts.

a) What type of account is the Checking Account?
b)  How many accounts of type Fixed Asset are in the Chart of Accounts?
C) How many accounts of type Income are in the Chart of Accounts?

While still in the Chart of Accounts, Double-click the Checking account on the Chart
of Accounts list. This will open the register for Checking account.

a) Who was the payee for the check on 2/10/2017?
b)  What was the amount of the check?
C) Close the checking account register and Chart of Accounts list.

Click the Create Invoices icon on the Home page, and then click on the Previous arrow
(top left).
a) What is the Invoice Number?

b)  What is the first [tem listed in this invoice?
C) Close the invoice.

Select the Chart of Accounts option from the Lists menu. Double-click on the
Checking account.

a) Which vendor was paid by the last bill payment in the register?
b)  What is the amount of the last bill payment in the register?
C) Close the Checking register and close the Chart of Accounts list.

Click the Write Checks icon on the Home page and follow these steps:

a)  Click on the Calendar icon immediately to the right of the Date field. Select
tomorrow’s date in the Date field and press Tab.

b) In the Pay to the Order of field, enter Berry, Ron. Press Tab.

C) Enter 80.00 in the Amount field and press Tab.

d)  Click in the Print Later check box at the top of the window.

e)  What is the city displayed in the Address field on the check for Ron Berry?

f) Click Clear and then close the check window.

Select the Chart of Accounts option from the Lists menu and double-click on Accounts
Receivable.

a) What is the ending balance in the account?
b)  Who was the customer on the last transaction in the register?
C) Close the register and the Chart of Accounts.

Click the Check Register button on the Home page.

a) Select 10100 - Checking from the Use Register dialog box.
b)  What is the ending balance in the checking register?
C) Close the Checking Register.

10. Close the working data file Intro-13Problem1.QBW.
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